Enterprise Operations Solution

**FINAL Enterprise Infrastructure Solutions (EIS)**

**Public Pricer User Guide**

Version 2.0

June 13, 2022

Prepared for:

**U.S. General Services Administration**

Office of the Chief Information Officer (OCIO)

CIO Modernization and Enterprise Transformation (COMET)

Enterprise Operations Solutions Support – Business Process (EOSS-BP)
# Table of Contents

1 Overview ................................................................................................................. 1  
   1.1 Background........................................................................................................ 1  
   1.2 Purpose ............................................................................................................. 1  
   1.3 Users .................................................................................................................. 1  
   1.4 Access ............................................................................................................... 1  

2 Home Page ............................................................................................................. 1  
   2.1 Overview Panel .................................................................................................. 2  
   2.2 Recent Changes Panel ...................................................................................... 2  
   2.3 Resources Panel ............................................................................................... 3  
   2.4 Contact Panel ................................................................................................... 3  
   2.5 Tools Menu ........................................................................................................ 3  

3 Address Lookup Page ........................................................................................... 4  
   3.1 Single Address Lookup Tab ............................................................................... 4  
      3.1.1 Examples ..................................................................................................... 6  
      3.1.2 Map Options ............................................................................................... 6  
      3.1.3 Check Service Availability ........................................................................ 10  

4 Awarded Items Page ............................................................................................... 11  
   4.1 Overview Tab ................................................................................................... 11  
      4.1.1 CBSAs by Vendor View ............................................................................. 11  
      4.1.2 Country/Jurisdictions by Vendor View ..................................................... 12  
      4.1.3 Services by Vendor View ......................................................................... 13  
   4.2 Awarded Items Tab ............................................................................................ 14  
      4.2.1 Awarded CBSAs View .............................................................................. 14  
      4.2.2 Services View ........................................................................................... 15  
      4.2.3 Vendor CBSAs View ............................................................................... 15  
      4.2.4 Vendor Country/Jurisdictions View ............................................................ 17  

5 CBSA Lookup Page ............................................................................................... 19  
   5.1 CBSAs Menu .................................................................................................... 20  
   5.2 Service Menu ................................................................................................... 21  
   5.3 Vendor Menu .................................................................................................... 23  
   5.4 Select a CBSA ................................................................................................ 24  
      5.4.1 CBSAs Details Dialog .............................................................................. 25  

6 Changes Page ........................................................................................................ 27
7  CLIN Lookup Page .............................................................................................................. 28
   7.1  Service Menu .............................................................................................................. 29
   7.2  Sort Menu ................................................................................................................... 30
   7.3  Search Field ............................................................................................................... 30
   7.4  CLIN List ................................................................................................................... 30
      7.4.1  CLIN Details Dialog .................................................................................... 31
8  Contract Mods Page ............................................................................................................ 41
   8.1  Mod Search Filter ....................................................................................................... 42
   8.2  Mod Vendor Menu ..................................................................................................... 42
   8.3  Mod Details Dialog ................................................................................................... 43
      8.3.1  Summary Tab ................................................................................................... 44
      8.3.2  CLINs Tab ......................................................................................................... 44
      8.3.3  Tables Tab ......................................................................................................... 45
9  Service Guides Page ............................................................................................................ 46
10  Unit Pricer Page ............................................................................................................... 48
   10.1  Toolbar .................................................................................................................... 48
       10.1.1  Add Price Button .......................................................................................... 48
       10.1.2  Download Button ......................................................................................... 49
       10.1.3  Result Sets Menu ......................................................................................... 49
       10.1.4  Vendor Menu ................................................................................................. 49
       10.1.5  Clear Results Button .................................................................................... 50
   10.2  Result List .................................................................................................................. 50
       10.2.1  Result Panel .................................................................................................... 51
   10.3  Add Price Dialog ....................................................................................................... 53
       10.3.1  Tab Sidebar ..................................................................................................... 53
       10.3.2  Navigation Buttons ....................................................................................... 54
       10.3.3  Title ................................................................................................................ 54
       10.3.4  Overview Tab ................................................................................................. 55
       10.3.5  Select CLIN Tab ............................................................................................ 55
       10.3.6  Select Additional Info Tab ............................................................................. 59
       10.3.7  Select Case Number Tab ............................................................................... 61
       10.3.8  Select Origin Tab ............................................................................................ 64
       10.3.9  Select Destination Tab .................................................................................... 67
       10.3.10 Select Quantity Tab ....................................................................................... 70
10.3.11 Select Pricing Element Tab ................................................................. 71
10.3.12 Select Date Range Tab ................................................................. 72
10.3.13 Confirm Selections Tab ................................................................. 73
10.4 Case Details Dialog ............................................................................ 76
10.5 Load Result Set Dialog ........................................................................ 78
10.5.1 Search Field ................................................................................... 78
10.5.2 Result Set List ................................................................................ 79
10.5.3 Toolbar ......................................................................................... 79
10.5.4 Load Result Set Button ................................................................. 79
10.6 Associated CLINs Dialog ................................................................. 80
10.7 Pricing Examples ................................................................................. 82
10.7.1 Two Locations ............................................................................. 82
10.7.2 Banded ......................................................................................... 82
10.7.3 Task Order ICB ........................................................................... 82
10.7.4 Pricing Hub (P-Hub) ................................................................. 82
10.7.5 SRE ......................................................................................... 82
10.7.6 SRE (Empty Price Result) ......................................................... 83
List of Figures

Figure 1: Public Pricer Home Page ................................................................. 2
Figure 2: Tools Menu .................................................................................. 3
Figure 3: Single Address Lookup Tab ............................................................ 4
Figure 4: Single Address Lookup Tab: Exact Match ........................................ 5
Figure 5: Single Address Lookup Tab: Approximate Match ............................. 5
Figure 6: Single Address Lookup Tab: CONUS Button .................................. 6
Figure 7: Single Address Lookup Tab: CONUS Display .................................. 7
Figure 8: Single Address Lookup Tab: Pair Button ......................................... 7
Figure 9: Single Address Lookup Tab: Pair Display ....................................... 8
Figure 10: Single Address Lookup Tab: Address Display ............................... 8
Figure 11: Single Address Lookup Tab: NSC Display ..................................... 9
Figure 12: Single Address Lookup Tab: CBSA Display .................................. 10
Figure 13: Single Address Lookup Tab: Check Service Availability ............... 11
Figure 14: Overview Tab: CBSAs by Vendor View ........................................ 12
Figure 15: Overview Tab: View Menu ......................................................... 12
Figure 16: Overview Tab: Country/Jurisdictions by Vendor View .................. 13
Figure 17: Overview Tab: Services by Vendor View ....................................... 13
Figure 18: Awarded Items Tab: Awarded CBSAs ........................................... 14
Figure 19: Awarded Items Tab: View Menu .................................................. 15
Figure 20: Awarded Items Tab: Services ....................................................... 15
Figure 21: Awarded Items Tab: Vendor CBSAs ............................................. 16
Figure 22: Awarded Items Tab: Vendor CBSAs: Vendor Menu ..................... 17
Figure 23: Awarded Items Tab: Vendor CBSAs: Download ............................. 17
Figure 24: Awarded Items Tab: Vendor Country/Jurisdictions ........................ 18
Figure 25: Awarded Items Tab: Vendor Country/Jurisdictions: Vendor Menu .... 18
Figure 26: Awarded Items Tab: Vendor Country/Jurisdictions: Download .......... 19
Figure 27: CBSA Lookup Page ................................................................. 19
Figure 28: CBSAs Menu ........................................................................... 20
Figure 29: CBSAs Menu: Top 100 CBSAs ................................................... 20
Figure 30: CBSAs Menu: Other CBSAs ...................................................... 21
Figure 31: Service Menu ............................................................................ 22
Figure 32: Service Menu: Internet Protocol Voice Service ............................ 23
Figure 33: Vendor Menu ............................................................................. 23
Figure 34: Vendor Menu: Vendor Selected .................................................. 24
Figure 35: Select Individual CBSA .............................................................. 25
Figure 108: Add Price Dialog: Confirm Selections Tab: Errors Panel ......................... 74
Figure 109: Add Price Dialog: Confirm Selections Tab: Review Panel ...................... 75
Figure 110: Add Price Dialog: Confirm Selections Tab: Find Prices Button ............... 76
Figure 111: Case Details Dialog .............................................................................. 77
Figure 112: Case Details Dialog: Comparisons Tab ................................................. 77
Figure 113: Load Result Set Dialog .......................................................................... 78
Figure 114: Load Result Set Dialog: Search Field ...................................................... 79
Figure 115: Load Result Set Dialog: Result Set List .................................................. 79
Figure 116: Load Result Set Dialog: Toolbar .............................................................. 79
Figure 117: Load Result Set Dialog: Load Result Set Button ..................................... 80
Figure 118: Associated CLINs Dialog ...................................................................... 81
Figure 119: Associated CLINs Dialog: Learn More .................................................... 82
Version History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Author</th>
<th>Reviewer</th>
<th>Approver</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/3/2022</td>
<td>V1.7</td>
<td>Brad Berlage</td>
<td></td>
<td></td>
<td>Add new cover page; Update headers &amp; footers w/ new ID#; Update version history table; Update TOC and List of Figures; Added EOS to List of Acronyms &amp; remove NS OPS; Change NHC to EOS Update Public Pricer URL and hyperlinks; Checked compatibility; Remove Content Control; Performed spelling and grammar check</td>
</tr>
<tr>
<td>6/13/2022</td>
<td>V2.0</td>
<td>Brad Berlage</td>
<td>Alex Kreimer</td>
<td></td>
<td>All revisions accepted. Marking as Final</td>
</tr>
</tbody>
</table>

List of Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGF</td>
<td>Associated Government Fee</td>
</tr>
<tr>
<td>AOW</td>
<td>Area of the World</td>
</tr>
<tr>
<td>AWS</td>
<td>Amazon Web Services</td>
</tr>
<tr>
<td>CBSA</td>
<td>Core-Based Statistical Area</td>
</tr>
<tr>
<td>CLIN</td>
<td>Contract Line Item Number</td>
</tr>
<tr>
<td>CONUS</td>
<td>Continental United States</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma Separated Value</td>
</tr>
<tr>
<td>CSVS</td>
<td>Circuit Switched Voice Service</td>
</tr>
<tr>
<td>DOM</td>
<td>Domestic</td>
</tr>
<tr>
<td>DPA</td>
<td>Delegation of Procurement Authority</td>
</tr>
<tr>
<td>EIS</td>
<td>Enterprise Infrastructure Solutions</td>
</tr>
<tr>
<td>EOS</td>
<td>Enterprise Operations Solution</td>
</tr>
<tr>
<td>FAS</td>
<td>Federal Acquisition Service</td>
</tr>
<tr>
<td>GSA</td>
<td>General Services Administration</td>
</tr>
<tr>
<td>ICB</td>
<td>Individual Case Basis</td>
</tr>
<tr>
<td>IPVS</td>
<td>Internet Protocol Voice Service</td>
</tr>
<tr>
<td>ITC</td>
<td>Office of Information Technology Category</td>
</tr>
<tr>
<td>MMC</td>
<td>Monthly Maintenance Charge</td>
</tr>
<tr>
<td>MRC</td>
<td>Monthly Recurring Charge</td>
</tr>
<tr>
<td>NHC</td>
<td>Network Hosting Center</td>
</tr>
<tr>
<td>NONDOM</td>
<td>Non-Domestic</td>
</tr>
<tr>
<td>NRC</td>
<td>Non-Recurring Charge</td>
</tr>
<tr>
<td>NSC</td>
<td>Network Site Code</td>
</tr>
<tr>
<td>NSP</td>
<td>Not Separately Priced</td>
</tr>
<tr>
<td>OCONUS</td>
<td>Outside Continental United States</td>
</tr>
<tr>
<td>P-Hub</td>
<td>Pricing Hub</td>
</tr>
<tr>
<td>RFP</td>
<td>Request For Proposal</td>
</tr>
<tr>
<td>SRE</td>
<td>Service Related Equipment</td>
</tr>
</tbody>
</table>
1 Overview

This user guide describes the General Services Administration (GSA) Enterprise Infrastructure Solutions (EIS) Enterprise Operations Solution (EOS) Services Public Pricer), which allows public users to compare prices for vendor telecommunication services provided under the EIS contract.

Step-by-step instructions are provided on how to use the Public Pricer.

1.1 Background

The EIS EOS Services Public Pricer is part of a set of web-based tools supported by the EOS. It allows users to price all Contract Line Item Numbers (CLINs) for all services and their features, for current and previous years, for all EIS vendors. The Public Pricer also displays service availability information based on specific location addresses.

1.2 Purpose

The Public Pricer allows users to search and view the prices of telecommunications products and services available under the EIS contract, by vendor.

1.3 Users

The primary users of the Public Pricer are members of the general public.

1.4 Access

The Public Pricer is available online at https://eis-public-pricer.eos.gsa.gov.

2 Home Page

Use the Public Pricer home page (Figure 1) to access all Public Pricer functions.
2.1 Overview Panel

At the top of the page, an **Overview panel** lists key functions of the Public Pricer:

- Convert street addresses to the closest Network Site Code (NSC)
- Check service availability by street address or NSC
- Map awarded Core-Based Statistical Areas (CBSAs)
- Download awarded services by CBSA, Country/Jurisdiction, and vendor
- Price CLINs across vendors

The Overview panel also provides a link to the Service Guides page (Section 9), and a link to email the EIS Help Desk.

Below the Overview Panel, a scrolling display previews the following functions in turn:

- Address Lookup (Section 3)
- Awarded Items (Section 4)
- CBSA Lookup (Section 4)
- Service Guides (Section 9)
- Unit Pricer (Section 10)

Click any scrolling display image to go to the page for the associated function.

2.2 Recent Changes Panel

The **Recent Changes panel** lists:

- The most recent Public Pricer updates
- The most recent integrated mods for all vendors and contracts

To go to the Changes page (Section 6), click the **View Older Changes link**.

### 2.3 Resources Panel

The **Resources panel** at the top right of the page contains a list of resource hyperlinks, including links to download an EIS CLINs spreadsheet, an EIS Delegation of Procurement Authority (DPA) spreadsheet, and an EIS Pricing Concepts document.

### 2.4 Contact Panel

The **Contact panel** provides the EIS Help Desk email address and phone number.

### 2.5 Tools Menu

The **Tools menu** in the header provides links to Public Pricer functions (Figure 2).

![Figure 2: Tools Menu](image)

The Tools menu links to the following functions:

- Address Lookup (Section 3)
- Awarded Items (Section 4)
- CBSA Lookup (Section 5)
- Changes (Section 6)
- CLIN Lookup (Section 7)
- Contract Mods (Section 8)
- Service Guides (Section 9)
- Unit Pricer (Section 10)
3 Address Lookup Page

To find NSCs associated with a street address, or the street (location) associated with an NSC, use the Address Lookup page.

By default, the Single Address Lookup tab is displayed (Section 3.1). To view online help, click the Help tab.

3.1 Single Address Lookup Tab

Use the Single Address Lookup tab to look up a single address or NSC (Figure 3).

When an address is entered, the tool displays a list of possible NSC matches in the left panel. The following information is displayed for each possible result:

- The normalized street address
- A label indicating if the result is an exact or approximate NSC match:
  - Exact matches are displayed in green (Figure 4)
  - Approximate matches are displayed in red (Figure 5)
- The closest NSC and NSC address
- The bounding CBSA for this NSC
To display a matching address and the closest NSC in the map on the right, select an entry from the list in the left panel (if there is only one, it is selected by default).
3.1.1 Examples

Some additional example street addresses and NSCs are provided below:

- “3150 fairview park dr, falls church va 22042”  
  (Street address that has an exact NSC match)
- “7309 carol ln, falls church va 22042”  
  (Street address without an exact NSC match)
- “2565 van buren st, eugene or”  
  (Street address without an exact NSC match, with multiple results)
- “FLCHVAEO”  
  (Sample NSC)

Note: Address and NSC strings are not case sensitive.

3.1.2 Map Options

Use the map panel header and footer buttons to quickly locate points of interest.

3.1.2.1 CONUS Button

To reset the map to a view of the Continental United States (CONUS) (Figure 7), click the **CONUS button** (Figure 6).
3.1.2.2 Pair Button

To pan the map to display both the street address and the NSC for the selected entry (Figure 9), click the Pair button (Figure 8).

Figure 7: Single Address Lookup Tab: CONUS Display

Figure 8: Single Address Lookup Tab: Pair Button
3.1.2.3 Address Button

To pan the map to display the street address for the selected entry (Figure 10), click the Address button.
3.1.2.4 NSC Button

To pan the map to display the NSC for the selected entry (Figure 11), click the **NSC button**.

![Figure 11: Single Address Lookup Tab: NSC Display](image)

3.1.2.5 CBSA Button

To pan the map to display the bounding CBSA for the selected entry (Figure 12), click the **CBSA button**.
3.1.3 Check Service Availability

To view available services by vendor at the bounding CBSA for the selected address (Figure 13), click the **Check Service Availability button** from the Single Address Lookup tab.
This window displays the following information for each vendor at the selected CBSA:

- **Vendor**: Vendor name.
- **Awarded**: The vendor’s award status for this CBSA
- **Voice Service**: The vendor's mandatory voice service at this CBSA (if awarded)

The remaining columns indicate whether the vendor was awarded each listed location-based optional or voice service at this CBSA.

To download the list of awarded location-based services in comma-separated value (CSV) format, click the Download button. To close the display, click Close.

4. **Awarded Items Page**

To view and download several reports about awarded CBSAs, awarded Country/Jurisdictions, and awarded services, use the Awarded Items page.

4.1 **Overview Tab**

4.1.1 **CBSAs by Vendor View**

To view a display of the CBSAs awarded to all vendors click the Overview tab (Figure 14). By default, the CBSAs by Vendor view displays.
Figure 14: Overview Tab: CBSAs by Vendor View

To display the awarded CBSAs for a specific vendor, click the display bar for that vendor (Section 4.2.3).

To access other awarded item views, use the View menu (Figure 19).

Figure 15: Overview Tab: View Menu

4.1.2 Country/Jurisdictions by Vendor View

To view a display of the Country/Jurisdiction awards for all vendors select the Country/Jurisdictions by Vendor view (Figure 16).
Figure 16: Overview Tab: Country/Jurisdictions by Vendor View

To display the Country/Jurisdiction awards for a specific vendor, click the display bar for that vendor (Section 4.2.4).

4.1.3 Services by Vendor View

To view a display of the awarded services for all vendors select the Services by Vendor view (Figure 17).

Figure 17: Overview Tab: Services by Vendor View

To display the awarded services for all vendors, click the display bar for any vendor (Section 4.2.2).
To view online help, click the **Help tab**.

### 4.2 Awarded Items Tab

#### 4.2.1 Awarded CBSAs View

By default, the **Awarded Items tab** and **Awarded CBSAs view** display (Figure 18). This view shows all awarded CBSAs by vendor. The rows are ordered by CBSA rank in the EIS contract. If a vendor was awarded a CBSA, it must offer all non-voice, location-based mandatory services at all NSCs within that CBSA.

![Figure 18: Awarded Items Tab: Awarded CBSAs](image)

To download the list of awarded CBSAs in CSV format, click the **Download button**. To access other awarded item views, use the **View menu** (Figure 19).
4.2.2 Services View

The Services view shows all awarded services (both location-based and non-location-based) and indicates whether they were awarded to each vendor (Figure 20).

![Figure 20: Awarded Items Tab: Services](image)

To download the list of awarded services in CSV format, click the Download button. To access other awarded item views, use the View menu (Figure 19).

4.2.3 Vendor CBSAs View

The Vendor CBSAs view (Figure 21) displays awarded location-based optional and voice services by CBSA for the vendor selected in the Vendor menu. This view
contains a row for each CBSA, ordered by CBSA rank in the EIS contract. The columns indicate whether the CBSA was awarded to the selected vendor, provide the vendor's awarded mandatory voice service for the CBSA, and indicate whether the vendor was awarded the location-based optional or voice services for the CBSA. Voice services are included because they could be awarded as optional services for the CBSA.

<table>
<thead>
<tr>
<th>CBSA Rank</th>
<th>CBSA Name</th>
<th>Mand. Voice</th>
<th>AA</th>
<th>CW</th>
<th>CSS</th>
<th>CSV</th>
<th>ETS</th>
<th>IP</th>
<th>IPv</th>
<th>LAB</th>
<th>MNS</th>
<th>MSS</th>
<th>MTP</th>
<th>OWS</th>
<th>PL</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Washington-Arlington-Alexandria, DC-VA-MD-WV</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Baltimore-Columbia-Towson, MD</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Durham-Chapel Hill, NC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Dallas-Fort Worth-Arlington, TX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Chicago-Naperville-Elgin, IL-IN-WI</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>San Jose-Sunnyvale-Santa Clara, CA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Salt Lake City, UT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Kansas City, MO-KS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Atlanta-Sandy Springs-Roswell, GA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Virginia Beach-Norfolk-Newport News, VA-NC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>St. Louis, MO-IL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Nashville-Davidson-Murfreesboro-Franklin, TN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 21: Awarded Items Tab: Vendor CBSAs

By default, the Vendor CBSAs view selects the first vendor on the list. To select a different vendor, use the Vendor menu (Figure 22).
To download the list of awarded CBSAs for the selected vendor in CSV format, click the **Download button**. The name of the vendor will be included in the file name (Figure 23).

**Figure 23: Awarded Items Tab: Vendor CBSAs: Download**

To access other awarded item views, use the **View menu** (Figure 19).

### 4.2.4 **Vendor Country/Jurisdictions View**

The **Vendor Country/Jurisdictions view** (Figure 24) displays awarded Country/Jurisdictions for the vendor selected in the Vendor menu. Each row in this report contains a Country/Jurisdiction. The columns indicate whether the selected vendor was awarded the Country/Jurisdiction, and whether the vendor was awarded the location-based services (mandatory or optional) at that Country/Jurisdiction.
By default, the Vendor Country/Jurisdictions view selects the first vendor on the list. To select a different vendor, use the Vendor menu (Figure 25).

To download the list of awarded Country/Jurisdictions for the selected vendor in CSV format, click the **Download button**. The name of the vendor will be included in the file name (Figure 26).
To access other awarded item views, use the **View menu** (Figure 19).

To view online help, click the **Help tab**.

5 **CBSA Lookup Page**

To display CBSAs on a map, use the **CBSA Lookup page** (Figure 27). The following display filters are available:

- CBSA Rank (Section 5.1)
- Location-based service (Section 5.2)
- Vendor (Section 5.3)

The filters listed above can be used either individually or in combinations.

To display detail information about a CBSA (Section 5.4), click that CBSA on the map.

By default, the CBSAs tab displays, and all CBSAs are shown for all services and vendors. To view online help, click the **Help tab**.
5.1 CBSAs Menu

To display a subset of the EIS CBSAs, use the CBSAs menu (Figure 28).

By default, the All CBSAs option is selected.

To display the top 100 CBSAs on the map, as ranked in the EIS contract (Figure 29), select Top 100 CBSAs on the CBSA menu.
To display all CBSAs other than the top 100 CBSAs on the map, as ranked in the EIS contract (Figure 29), select **Other CBSAs** on the CBSA menu.

![Figure 30: CBSAs Menu: Other CBSAs](image)

### 5.2 Service Menu

To limit the map display to CBSAs where an individual service was awarded, use the **Service menu** (Figure 28). Services are grouped into the following categories:

- Access Arrangements
- Data Service
- Voice Service
- Managed Services
- Service Related Equipment
- Service Related Labor
- Cable and Wiring

By default, the **All Services option** is selected.
For example, selecting the Internet Protocol Voice Service option displays only those CBSAs where that service was awarded (Figure 32).
5.3 Vendor Menu

To display CBSAs awarded to a specific vendor, use the Vendor menu (Figure 33).
For example, selecting the vendor “A-Com” displays only those CBSAs awarded to that vendor (Figure 34).

![Figure 34: Vendor Menu: Vendor Selected](image)

To reset the map to a view of CONUS, click the CONUS button.

### 5.4 Select a CBSA

Scroll up or down to zoom toward or away from the map. Click an individual CBSA to select and zoom in on it. A brief description of the CBSA will display, along with a **Show Details button** (Figure 35).
5.4.1 CBSAs Details Dialog

To open the CBSA Details dialog (Figure 36), after an individual CBSA has been selected, click the Show Details button. The following information will display for the selected CBSA:

- Vendors that were awarded the CBSA
- The mandatory voice service for each vendor awarded the CBSA
- Location-based optional or voice services awarded to each vendor at the CBSA
For additional information on how services are awarded at each CBSA, click the **Learn More button** in the CBSA Details dialog (Figure 37). To close the dialog, click **Close**.
Figure 37: Select Individual CBSA: CBSA Details Dialog: Learn More

6 Changes Page

To display a list of the following items, use the Changes page (Figure 38):

- Public Pricer updates
- Integrated mods for all vendors and contracts
To download the changes list in CSV format, click the **Download button**.

### 7 CLIN Lookup Page

Use the **CLIN Lookup page** (Figure 39) to:

- Browse or search CLINs by service and search terms
- Sort matching CLINs by CLIN or by name
- Download matching CLINs as a CSV file
- Display detail information for individual CLINs
7.1 Service Menu

To filter the list of CLINs displayed by service, use the Service menu (Figure 40).
7.2 Sort Menu
To sort the CLINs displayed by CLIN or by Name, use the Sort menu (Figure 41).

Figure 41: Sort Menu

7.3 Search Field
To display only CLINs that match a CLIN or Name, use the Search field (Figure 42).

Figure 42: Search Field

7.4 CLIN List
The CLIN list (Figure 43) displays CLINs that match the Services menu and Search field filters, sorted by the Sort menu. Each entry contains the following information:

- Service ID
- CLIN
- CLIN Name
- Frequency
- Unit
To navigate between pages of the CLIN list, use the **Pager bar** at the bottom of the list (Figure 44). Click the **Download button** to download the search results as a CSV file.

**Figure 43: CLIN List**

**Figure 44: Pager**

### 7.4.1 CLIN Details Dialog

To display detail information about a CLIN, click an entry in the CLIN list to open the corresponding **CLIN Details dialog** (Figure 45) which provides the following tabs:

- **CLIN Details tab**: Displays basic attributes of the selected CLIN
- **Associated CLINs tab**: Displays CLINs associated with the selected CLIN
- **Auto-Sold CLINs tab**: Displays Auto-Sold CLINs associated with the selected CLIN
- **B-Tables tab**: Displays B-Tables associated with the selected CLIN
- **Contract Mods tab**: Displays contract mods that have affected prices for the selected CLIN
- **Help tab**: Displays documentation for the CLIN Details Dialog

#### 7.4.1.1 CLIN Details Tab

The **CLIN Details tab** (Figure 45) displays the following attributes of the selected CLIN:

- **CLIN**: A 7-digit alphanumeric string that uniquely identifies this Contract Line Item Number (CLIN)
- **CLIN Name**: The name of this CLIN
- **Frequency**: The charging frequency of this CLIN:
  - **MRC**: Monthly-Recurring Charge
  - **NRC**: Non-Recurring Charge
- **Usage**: Usage-based charging
- **Charging Unit**: The charging unit of this CLIN
- **Mandatory CLIN**: Whether this CLIN is mandatory
- **NSP**: Whether this CLIN is Not Separately Priced (NSP)
- **Service ID**: The unique identifier for the parent service of this CLIN
- **Service Name**: The name of the parent service of this CLIN
- **Section Number**: The Request For Proposal (RFP) section number of the parent service of this CLIN
- **CBSA Based Service**: Whether the parent service of this CLIN is CBSA-based (i.e., the parent service is awarded by CBSA for domestic regions and by Country/Jurisdiction for non-domestic regions)
- **Mandatory Service**: Whether the parent service of this CLIN is a mandatory service
  Note: Vendors must offer one mandatory voice service at all awarded CBSAs
- **Voice Service**: Whether the parent service of this CLIN is a voice service (i.e., Circuit Switched Voice Service [CSVS] or Internet Protocol Voice Service [IPVS])
  Note: Vendors must offer one mandatory voice service at all awarded CBSAs
- **CLIN Notes**: Any additional notes about this CLIN

![Figure 45: CLIN Details Dialog: CLIN Details Tab](image)
To price this CLIN, click the **Price CLIN button** to open the **Unit Pricer** (Section 10).

To view the service guide for the parent service, click the **View Service Guide** button to open the **Service Guides page** (Section 9).

To view the CBSAs where the parent service was awarded (if the parent service is CBSA-based) click the **Check Service Availability button** to open the **CBSA Lookup page** (Section 4).

### 7.4.1.2 Associated CLINs Tab

The **Associated CLINs tab** (Figure 46) lists CLINs associated with the current CLIN.

**Note:** Many CLINs have corresponding associated CLINs that should be priced together to calculate a complete price. For example, a Monthly Recurring Charge (MRC) CLIN may have one or more associated Non-Recurring Charge (NRC) CLINs, and vice-versa.

Each entry in the list of associated CLINs contains the following information:

- CLIN
- CLIN Name
- Charging Frequency
To view the details of an associated CLIN, select it and click the **View Details button**. To price this CLIN, select it and click the **Price CLIN button** to open the **Unit Pricer** (Section 10).

To download the list of associated CLINs as a CSV file, click the **Download button**.

### 7.4.1.3 Auto-Sold CLINs Tab

The **Auto-Sold CLINs tab** (Figure 47) displays a list of auto-sold CLINs associated with the current CLIN and the selected vendor. Each entry in the list contains the following information:

- CLIN
- CLIN Name
- Charging Frequency
- Case Number
To select a different vendor, use the **Vendor menu**.

To view the details of an auto-sold CLIN, select it and click the **View Details button**.

To price an auto-sold CLIN, select it and click the **Price CLIN button** to open the **Unit Pricer** (Section 10).

To download the list of auto-sold CLINs as a CSV file, click the **Download button**.

### 7.4.1.4 B-Tables Tab

The **B-Tables tab** (Figure 48) lists price tables that may contain prices for this CLIN. Each entry in the list contains the following information:

- **Section**: The RFP section that describes the structure of this table
- **Name**: Table name
- **Description**: A brief description of this table
7.4.1.5 Contract Mods Tab

The Contract Mods tab (Figure 49) displays contract modifications that have affected this CLIN.

To limit the display list to a specific vendor, use the Vendor menu.

To search the available mods, use the Search field.

Each entry in the list contains the following information:

- Vendor Name
- Awarded Mod ID
- Award Date
- Summary
To view additional details in the **Mod Details dialog**, click on an entry in the mod list.

### 7.4.1.5.1 Mod Details Dialog

The **Mod Details dialog** shows additional details about the given contract modification.

**Summary Tab**

The **Summary tab** (Figure 50) shows the summary text for the selected mod.
**CLINs Tab**

The **CLINs tab** (Figure 51) lists CLINs affected by the selected mod.
To view a CLIN in the CLIN Details dialog, click on a list entry.
To download the list of CLINs as a CSV file, click the **Download** button.

**Tables Tab**

The **Tables tab** (Figure 52) lists the tables affected by the selected mod.
To download the list of tables as a CSV file, click the **Download button**.

### 7.4.1.6 Help Tab

The **Help tab** (Figure 53) displays help information for the CLIN Details dialog.
8 Contract Mods Page

To display a list of contract mods, and to search mods by vendor and search string (Figure 54), use the **Contract Mods page**. By default, all mods are displayed.
Each entry in the list contains the following information:

- **Vendor Name**: The vendor name
- **Awarded Mod ID**: The unique identifier for the mod
- **Awarded Date**: The date the mod was awarded
- **Summary**: A brief summary of the changes in the mod

To view details in the **Mod Details** dialog, click any entry in the mod list.

### 8.1 Mod Search Filter

To filter the mod list (Figure 55), type a search string in the **Search field** and press the **[Enter] key**.

![Figure 55: Contract Mods Page: Search Filter](image)

### 8.2 Mod Vendor Menu

To filter the mod list by vendor (Figure 57), use the **Vendor menu** (Figure 56).
8.3 Mod Details Dialog

The **Mod Details dialog** displays details about the currently selected mod.
8.3.1 Summary Tab
By default, the Summary tab displays, showing a summary of the mod (Figure 58).

![Figure 58: Contract Mods Page: Mod Details Dialog: Summary Tab](image)

8.3.2 CLINs Tab
The CLINs tab shows a list of CLINs that are modified by the selected mod (Figure 59).
Each row in the list of CLINs contains the following information:

- Service
- CLIN
- CLIN Name
- Table Name
- Table Reference Number (EIS RFP Section B Table ID)
- Change Type

To price a CLIN in the Unit Pricer, click an entry in the list.
To download the list of CLINs as a CSV file, click the **Download button**.

8.3.3 Tables Tab

The **Tables tab** shows a list of tables that are modified by the selected mod (Figure 60).
Each row in the list of tables contains the following information:

- Table Name
- Table Reference Number (B-Table ID)
- Change Type

To download the list of tables as a CSV file, click the **Download button**.

9 **Service Guides Page**

The **Service Guides page** contains EIS service guides provided by GSA (Figure 61).
The left sidebar displays an Overview, followed by a list of the available service guides. The right panel displays the content of the topic that is currently selected.

Use the search field at the top of the left sidebar to filter the list of visible guides. Click CLIN links in the right panel (Figure 62) to open them in the Unit Pricer.

**Example 1: T1 Access**

**Service CLINs**

- Choose **CLINs AA00003 and AA00103** for T1 (1.536 Mbps) (NRC and MRC) (see EIS contract table B.2.9.1.5—Access Pricing Instructions Table).

**Example 2: Shared Ethernet Access 300 Mbps committed, scalable to 1 Gbps**

**Service CLINs**

- Choose **CLINs AA00907 and AA00907** for Shared Ethernet Access 300 Mbps committed, scalable to 1 Gbps (NRC and MRC) (see EIS contract table B.2.9.1.5—Access Pricing Instructions Table).
- Choose **CLIN AA00922** for Ethernet Access Bandwidth-on-Demand temporary bandwidth increase of 100 Mbps per day: 100 Mbps ≤ committed bandwidth < 1 Gbps (see EIS contract table B.2.9.1.5—Access Pricing Instructions Table).
10 Unit Pricer Page

To search and view the prices of telecommunications products and services available under the EIS contract, use the **Unit Pricer** page (Figure 63).

![Figure 63: Unit Pricer Page](image)

By default, the Unit Pricer tab displays. To view online help, click the Help tab.

10.1 Toolbar

To work with service prices, use the **Toolbar** (Figure 64).

![Figure 64: Unit Pricer Toolbar](image)

The Toolbar supports the following functions:
- **Add Price button** (Section 10.1.1): Add a new price result to the Result list (Section 10.2)
- **Download button** (Section 10.1.2): Download the Result list as a CSV file
- **Result Sets menu** (Section 10.1.3): Save the current Result list as a Result set or load a previous Result set into the Result list
- **Vendor menu** (Section 10.1.4): Filter the price results in the Result list by vendor
- **Clear Results button** (Section 10.1.5): Clear the Result list

10.1.1 Add Price Button

To display the **Add Price dialog** (Section 10.3), click the Add Price button (Figure 65).

![Figure 65: Toolbar: Add Price Button](image)
10.1.2 Download Button
To download the current Result list as a CSV file, click the **Download button** (Figure 66).

![Download Button](image)

*Figure 66: Toolbar: Download Button*

A prompt will display at the bottom of the user’s screen with options to open the file, save the file to a user-specified location, or cancel the download, (Figure 67).

![Download Options](image)

*Figure 67: Toolbar: Download Options*

10.1.3 Result Sets Menu
To work with Result sets, use the **Result Sets menu** (Figure 68).

![Result Sets Menu](image)

*Figure 68: Toolbar: Result Sets Menu*

The menu supports the following options:
- **Load Result Set**: Load a previously-saved Result Set and display the **Load Result Set dialog** (Section 10.5)
- **Save Result Set**: Save the current Result list as Result set

10.1.4 Vendor Menu
To filter the current price results in the Result list by vendor, use the **Vendor menu** (Figure 69).
To limit the price results in the Result list to an individual vendor, click the name of that vendor. To select multiple vendors, use the [Shift] key. To clear the vendor filter, click All.

10.1.5 Clear Results Button
To clear the current price results in the Result list, click the Clear Results button (Figure 70).

10.2 Result List
The Result list displays the current price results (Figure 71).
When applicable, the Associated Government Fee (AGF) is included in the price results, and a note to that effect displays above the price list.

To modify the Result list, use the Toolbar options (Section 10.1).

### 10.2.1 Result Panel

Each Result panel (Figure 72) contains the result of a single Add Price dialog lookup (Section 10.3).

The panel header contains:

- An **Options menu** (accessed by clicking the gear button)
- A **CLIN Details panel** (accessed by clicking the Result panel title)

The Result panel body contains a table with a row for each unique date range and task order combination, based on the selections made in the Add Price dialog.

#### 10.2.1.1 Options Menu

To work with an individual Result Panel, use the **Options menu** (Figure 73).
The Options menu contains the following entries:

- **Edit Result**: Edit the settings for this price result
- **Copy Result**: Create a duplicate copy of this price result
- **Delete Result**: Delete this price result from the Result list
- **View Associated CLINs**: Display the Associated CLINs dialog (Section 10.6).

### 10.2.1.2 CLIN Details Panel

To display details about a price result, use the **CLIN Details panel** (Figure 74).

The CLIN Details panel displays the following:

- Service Name
- CLIN and CLIN Name
10.3 **Add Price Dialog**

The **Add Price dialog** guides the user through the steps necessary to search for prices of telecommunications products and services (Figure 75).

![Add Price Dialog](image)

**Figure 75: Add Price Dialog**

10.3.1 **Tab Sidebar**

The left sidebar of the Add Price dialog displays the set of available steps as a vertical list of tabs, with the currently active tab highlighted in blue (Figure 76).

![Tab Sidebar](image)

**Figure 76: Add Price Dialog: Tab Sidebar**
Note: The tabs visible in the sidebar change based on the selections made in the Select CLIN tab (Section 10.3.5) and Select Additional Info tab (Section 10.3.5.6).

10.3.2 Navigation Buttons

To navigate to the previous and next step in the Add Price dialog, use the **Previous Step** and **Next Step** buttons in the lower right corner (Figure 77).

![Figure 77: Add Price Dialog: Navigation Buttons](image)

To quickly navigate between steps, click the tabs in the sidebar. To close the dialog, click the **Close button** at the left.

10.3.3 Title

Once a CLIN has been selected a CLIN on the Select CLIN tab, the **Title** will contain a summary of the current CLIN (Figure 78).

![Figure 78: Add Price Dialog: Title](image)
10.3.4 Overview Tab

The **Overview tab** describes the Add Price dialog (Figure 79).

![Add Price Dialog: Overview Tab](image)

**Figure 79: Add Price Dialog: Overview Tab**

10.3.5 Select CLIN Tab

To find and select a CLIN, use the **Select CLIN tab** (Figure 80).
10.3.5.1 Service Menu

To browse the list of available services and filter the CLINs in the Result list, use the Service menu (Figure 81).
10.3.5.2 Sort Menu
To sort the Result list by CLIN or CLIN Name, use the Sort menu (Figure 82).

10.3.5.3 Help Button
To display the help text for the Select CLIN tab, use the Help button (Figure 83).
10.3.5.4 Search Field

To search for a CLIN, use the **Search field** (Figure 84).

![Search Field](image)

Search strings are matched against the following:

- CLIN
- CLIN Name
- Service
- Service Name
To select a search string that was previously entered during the current session, use the **Search History menu** on the right side of the Search field (Figure 85).

![Search History](image)

**Figure 85: Add Price Dialog: Select CLIN Tab: Search Field: Search History**

### 10.3.5.5 Result List

The **Result list** (Figure 86) displays the list of CLINs that match the filter settings defined using the Service menu and Search field.

![Result List](image)

**Figure 86: Add Price Dialog: Select CLIN Tab: Result List**

### 10.3.5.6 Sample Downloads

To download all CLINs, click the Search field and press [Enter]. When the Result list appears, click the Download button and save the file to the desired location.

To download all ICB CLINs, type “ICB” in the Search field and press [Enter]. When the Result list appears, click the Download button and save the file to the desired location.

### 10.3.6 Select Additional Info Tab

To specify additional pricing information for the selected CLIN, use the **Select Additional Info tab** (Figure 87).
If there is more than one way to price the selected CLIN, vendors can offer different prices depending on the jurisdiction of each location. For example, vendors may offer one price if both sides of a connection are within the continental United States and another price if one side is outside the United States.

Common location jurisdiction terminology:

- CONUS: Continental United States
- OCONUS: Domestic locations outside the Continental United States, such as Hawaii, Alaska, and Puerto Rico.
- DOM: Domestic locations. All CONUS and OCONUS locations.
- NONDOM: Non-Domestic locations.

The left panel of the Select Additional Info tab lists pricing options, such as the location jurisdictions that are available for the specified CLIN. To continue pricing the CLIN, select an option.

The right panel provides detail information that is associated with the currently selected pricing option in the left panel. This information includes:

- The name of the table to search to obtain prices
- A list of additional selections that will be needed to price the selected CLIN (e.g., Case Number, Origin, Destination, Quantity, and/or Date Range)
Note: the entries in the Tab Sidebar (Section 10.3.1) will also change depending on which pricing option is selected.

10.3.7 Select Case Number Tab

To enter a case number for the currently selected CLIN, use the Select Case Number tab (Figure 88).

![Figure 88: Add Price Dialog: Select Case Number Tab](image)

Note: This tab is only displayed if an Individual Case Basis (ICB) CLIN was selected in the Select CLIN tab (Section 10.3.5).

10.3.7.1 Vendor Menu

To filter the list of case numbers displayed in the Select Case Number tab by vendor, use the Vendor menu (Figure 89).
Note: The **All Vendors** option is available for Catalog and SRE CLINs only.

### 10.3.7.2 Show Case Details Button

To display the Case Details dialog (Section 10.4) for the selected case number, use the **Show Case Details button** (Figure 90).

#### Figure 90: Add Price Dialog: Select Case Number Tab: Show Case Details Button

### 10.3.7.3 Help Button

To display help text for the Select Case Number tab, use the **Help button** (Figure 91).
10.3.7.4 Search Field

To search for a case number, use the Search field (Figure 92). Enter a text string and press the [Enter] key. Unless otherwise stated, the text string may contain a partial value (e.g., searching for “ABC123” will match both “ABC123435” and “5321ABC123”). Note: for non-Catalog, non-SRE ICB CLINs, the search string must exactly match the case number to return results. For Catalog and SRE CLINs, the search string will be matched against the case number, case description, and item description (e.g., the manufacturer and part number).
10.3.7.5 Result List

The Result list (Figure 93) displays case numbers for the selected CLIN that match the filter settings in the Vendor menu and Search field.

![Figure 93: Add Price Dialog: Select Case Number Tab: Result List](image)

10.3.8 Select Origin Tab

To search for and select an origin location for the currently selected CLIN, use the Select Origin tab (Figure 94).
The functionality of this tab varies slightly depending on the type of location required:

- **Network Site Code (NSC):** Enter a street address or NSC in the search field, then press the [Enter] key to search for the closest NSC
- **Country/Jurisdiction:** Select a Country/Jurisdiction from the list
- **Area of the World (AOW):** Select an Area of the World from the list

Note: This tab is only visible if the selected CLIN and the pricing method selected in the Select Additional Info tab (Section 10.3.5.6) have an originating location requirement.

### 10.3.8.1 Search Field

To filter the list of visible locations, use the **Search field** (Figure 95). Enter a text string and press the [Enter] key.
To quickly access previous NSC or address searches for NSC locations, click the arrow at the right of the Search field to display the **Search History** menu (Figure 96).

### 10.3.8.2 Result List

The **Result list** (Figure 97) is a list of locations that match the search criteria defined using the Search field.
10.3.9 Select Destination Tab

To search for and select a destination location for the currently selected CLIN, use the Select Destination tab (Figure 98).
The functionality of this tab varies slightly depending on the type of location required:

- **Network Site Code (NSC):** Enter a street address or NSC in the search field, then press the [Enter] key to search for the closest NSC.
- **Country/Jurisdiction:** Select a Country/Jurisdiction from the list.
- **Area of the World (AOW):** Select an Area of the World from the list.

Note: This tab is only visible if the selected CLIN and the pricing method selected in the Select Additional Info tab (Section 10.3.5.6) have a destination location requirement.

### 10.3.9.1 Search Field

To filter the list of visible locations, use the **Search field** (Figure 99). Enter a text string and press the [Enter] key.
To quickly access previous NSC or address searches for NSC locations, click the arrow at the right of the Search field to display the **Search History** menu (Figure 100).

**10.3.9.2 Result List**

The **Result list** (Figure 101) is a list of locations that match the search criteria defined using the Search field.
10.3.10 Select Quantity Tab
To select a unit quantity for the selected CLIN, use the Select Quantity tab (Figure 102).
The price for the selected CLIN can vary based on the quantity purchased. For example, vendors may offer a price when buying 1-10 units, another price when buying 11-20 units, and so on. The unit of measurement for the quantity (the charging unit) is displayed to the right of the quantity field. The price results displayed for the selected CLIN are the price per unit multiplied by the specified quantity.

Note: This tab is only displayed if the selected CLIN has prices that vary by quantity.

10.3.11 Select Pricing Element Tab

To select a pricing element for the selected CLIN, use the Select Pricing Element tab (Figure 103). Pricing elements include: Non-Recurring Charge (NRC), Monthly Maintenance Charge (MMC), or Monthly Recurring Charge (MRC) for Service Related Equipment (SRE), Installation, Inside Move, Upgrade, Installment, etc.

![Figure 103: Add Price Dialog: Select Pricing Element Tab](image)

Note: This tab is only displayed if the selected CLIN has multiple pricing elements.
10.3.12 Select Date Range Tab

To select a date range to search for prices, use the Select Date Range tab (Figure 104).

By default, the “This Month through Remaining Available Years” option is selected.

10.3.12.1 Date Range Buttons

To select common date ranges, use the Date Range buttons (Figure 105).

10.3.12.2 Custom Date Range

To specify an arbitrary date range, use the Custom Date Range button and fields (Figure 106).
10.3.13 Confirm Selections Tab

To confirm the selections from previous tabs, correct any errors, and start the price search, use the **Confirm Selections tab** (Figure 107).

To start the price search for the selected CLIN, click the **Find Prices button**.

10.3.13.1 Errors Panel

To check if any invalid selections were made on a previous tab, or if any steps were skipped, use the **Errors panel** (Figure 108). To display detail information, click an individual error entry.
10.3.13.2 Review Panel

To review selections from previous tabs, use the Review panel (Figure 109).
10.3.13.3 Find Prices Button

To begin searching for matching prices once the selections have been reviewed, click the **Find Prices button** (Figure 110).
Figure 110: Add Price Dialog: Confirm Selections Tab: Find Prices Button

10.4 Case Details Dialog

To display any details provided by the vendor about the selected case number, use the Case Details dialog (Figure 111).
The **Comparisons tab** is only visible when an SRE CLIN is selected (Figure 112).
This tab compares SRE case number prices between vendors by matching the manufacturer, model number, and part number, and lists the case numbers from other vendors that will be compared against the price for the currently selected case number. Click the **Download button** to download the comparison list as a CSV file.

### 10.5 Load Result Set Dialog

To load a previously saved Result set, use the **Load Result Set dialog** (Figure 113).

#### 10.5.1 Search Field

To filter the visible list of saved results, use the **Search field** (Figure 114). Enter a text string and press the `[Enter] key`. 

---

**Figure 113: Load Result Set Dialog**
10.5.2 Result Set List
The Result Set list (Figure 115) is a list of saved Result sets that match the search criteria defined using the Search field.

10.5.3 Toolbar
To rename or delete a saved Result set, use the Toolbar buttons (Figure 116).

10.5.4 Load Result Set Button
To load the selected result set, use the Load Result Set button (Figure 117).
10.6 Associated CLINs Dialog

To list any CLINs associated with the selected CLIN, use the **Associated CLINs dialog** (Figure 118). Access the dialog from the Result Panel Options menu (Section 10.2.1.1).
To price one of the CLINs in the list, select it and click the **Price CLIN button**.

To download the list of associated CLINs in CSV format, click the **Download button**. Click **Close** to close the dialog.

For additional information on associated CLINs, click the **Learn More button** in the Associated CLINs dialog (Figure 119).
10.7 Pricing Examples

The following examples can be used to demonstrate different types of pricing.

10.7.1 Two Locations

- CLIN: VS13010
- Additional Info: OCONUS or Non-Domestic to OCONUS or Non-Domestic usage
- Origin: Domestic: Alaska
- Destination: Domestic: Hawaii

10.7.2 Banded

- CLIN: CC00102
- Quantity: Vary quantity to see how price per unit changes

10.7.3 Task Order ICB

- CLIN: AC99990
- Case Number: 1001

Note: This will return no result using the Public Pricer, since the price is task order specific.

10.7.4 Pricing Hub (P-Hub)

- CLIN: AA00101
- Additional Info: Domestic
- Origin: 3150 Fairview Park Dr Falls Church VA 22042

10.7.5 SRE

- CLIN: EQ90001
• Additional Info: ICB AOW
• Case Number: A-Com 1
• Origin: CONUS
• Pricing Element: SRE NRC

10.7.6 SRE (Empty Price Result)
• CLIN: EQ90001
• Additional Info: ICB Price
• Case Number: A-Com 1
• Pricing Element: SRE NRC (has no price), Installation NRC (has price)